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Description 

This is a 1.5-day training course to go over the fundamentals of creating a 3D Model for existing features to 

include; hard surfaces (i.e. asphalt, concrete, sidewalks, curbs, etc…), utilities, drainage structures and soil 

borings.  Participants will be introduced to Bentley OpenRoads Designer CONNECT Edition - OpenRoads 

Technology tools for design and modeling; specifically for Florida Department of Transportation (FDOT) 

projects using the FDOTCONNECTXX.XX Workspace.  Several new technologies will be introduced including: 

Objectives 

• Create and Set Up a MODLRD_ExistingFeatues using the SURVRD. 

• Create Shapes using FDOT Create Existing Features Tool 

• Create Existing Feature Terrains 

• Clip Terrains 

• Apply Surface Templates 

• Edit Existing Feature Depth 

• Add Curbs to the Existing Features  

• Create a GDTMRD file using the SURVRD. 

• Show Existing ROW Lines for Cross Sections 

• Create and Set Up a MODLRD_ExistingUtilities using the SURVRD. 

• Create and Set Up a MODLRD_ExistingDrainage using the SURVRD. 

• Create and Set Up a RWDTRD file for existing and Proposed Right of Way Lines 

• Create and Set Up a ABORRD file for Geotechnical Data. 

Audience 

• FDOT Roadway Designers and Engineers 

Prerequisites 

Participants need to have a basic understanding of Computer Aided Drafting and Design (CADD) using 

MicroStation, a basic understanding of OpenRoads Designer CONNECT Edition - OpenRoads Technology tools 

and a solid understanding of the engineering necessary to design a Roadway. 

Duration: 12 Hours   

Professional Credit Hours:  12 PDHs 

Note PDH Credits will only be available with Instructor lead or Computer Based Training (CBT) thru Learning 
Curve. 

  

http://www.fdot.gov/cadd/
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INTRODUCTION 

This course was developed to introduce OpenRoads Designer CONNECT Edition - OpenRoads Technology tools 

for design and modeling on Florida Department of Transportation (FDOT) projects.  The curriculum was 

developed within the FDOTCONNECTXX.XX Workspace to provide sample exercises for most of the new Civil 

Tools on a sample project data set. 

COURSE OBJECTIVES 

Participants of this course will be introduced to the newest OpenRoads Technology and a Workflow for 

designing two dimensional (2D) Plans, Profiles, Cross Sections and three dimensional (3D) Models for 

Construction Deliverables.  At successful completion they will have learned how to: 

• Create Terrain Elements to be used as hard surfaces (i.e. asphalt, concrete, sidewalks, curbs, etc..) 

• Develop Existing Feature Terrain Surfaces to be shown on cross sections and used in earthwork calculations 

• Export out the Existing Terrain Element using Landxml and then import into a GDTMRD file to be used for 

the Existing Ground  

• Create a Right of Way file that will be used to display ROW lines in Cross Sections 

• Create a Model of Existing Utilities to be shown on Cross Sections 

• Create a Model of Existing Drainage to be shown in Cross Sections. 

• Create a Model to display Core Borings  

 

FDOTCONNECTXX.XXFDOTCONNECTXX.XX 
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EXPECTATIONS – WHAT THIS COURSE PROVIDES 

This course provides a standard workflow for  modeling existing features on a project with Bentley Systems 

OpenRoads Designer CONNECT Edition - OpenRoads Technology within the FDOTCONNECTXX.XX 

Workspace. Although the majority of tools are used throughout, this course does not provide a description of 

every Bentley Systems OpenRoads Designer CONNECT Edition - OpenRoads Technology Civil Tool.  

Integrated help for each of the tools can be found by selecting FILE then going to the backstage and selecting 

Help to bring up Bentley’s ONLINE HELP or from the Ribbon pick the HELP icon.   

 

FILE>HELP 
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DOCUMENT STYLE 

Style conventions used throughout the course guide are shown in the following table. 

Item Convention Example 

Menu names 

and 

commands 

Bold N 

(Names separated 

with > symbol) 

• File > Open 

• File > ComSelect > Design 

Dialog box 

Actions 
Bold 

 

• Click the Apply button. 

• Click the Graphic Select button to the right 
of the Horizontal Alignment Include box. 

• In the Segment Type list, click Lines. 

Dialog box 

Field Names 
Italic • Key in Hemfield Road in the Alignment 

Name field. 

• Click the Graphic Select button to the right 
of the Horizontal Alignment Include field. 

• In the Segment Type list, click Lines. 

Key-ins Bold • Key in Hemfield Road in the Alignment 
Name field. 

File Names Italic • Open the file ALGNRD01.dgn in the 
C:\WorkSets\FDOT\22049555201\Roadway. 

File Paths Non italic 

 

• Open the file _Blank.dgn in the 
C:\WorkSets\FDOT\22049555201 

New Terms 

or Emphasis 
Italic 

 

• The Template Library contains templates, 
which represent typical sections of the 
proposed roadway. 

 

We would like to introduce the user to a new workflow terminology using the Ribbon if you see a direction like this. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line From Element>Simple Line From 

Element 

This means we are in the WorkFlow of OpenRoads Modeling which has a Tab named Geometry and has tools 

that are located in the Horizontal Group. Now that we are in the right workflow, Tab and Group we may need 

to click on a tool that has more than one option. 
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FILE TYPES 

The Bentley Systems GEOPAK OpenRoads Technology road design process now uses a single source file 

type, the DGN file.  All pertinent design data is stored in the design file. This information can be viewed through 

the Project Explorer and reported on in the Civil Report Browser. 

Below is a brief description of the legacy file types used in GEOPAK which can be imported or exported (i/o) 

with OpenRoads Technology. 

File Type Description: 

• Surface.tin (i/o) - A binary file, also known as a GEOPAK digital terrain model (DTM), that stores features 

made up of random points, break lines, and boundary data along with triangulated surface model. The features 

and the triangles together represent an existing ground surface. 

• Surface.dat (i) - A binary (or ASCII) file containing string and point information that is used for digital terrain 

model construction. 

• Surface.dtm (i/o) – A binary file, also known as a Roadway Designer digital terrain model, that stores features 

made up of components, break lines, and boundary data along with triangulated surface model. The features 

and the triangles together represent either existing ground surface or the proposed roadway corridor model. 

• Template Library.itl (i) - Stores templates and template components. Different components can be assembled 

to build templates, which define the typical sections of a roadway. Only one Template Library file may be 

open for editing at a given time. 

LEARNING RESOURCES 

There are several resources available for learning about the various Bentley Systems OpenRoads Designer 

CONNECT edition OpenRoads Technology tools. Among them are: 

• Bentley Communities:  

https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/33435/openr

oads-designer 

http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-

faqs.aspx 

• Bentley Learn: 

Bentley Institute site is for registered user and may require a Select Server site license to participate:  

https://learn.bentley.com 

• Bentley Product OpenRoads: 

Videos are available on a variety of topics: https://www.Bentley.com 

• YouTube: 

Bentley OpenRoads Videos are available on a variety of topics: http://www.youtube.com/user/BentleyCivil 

• YouTube Search - Google:  

Bentley OpenRoads returns several sites with videos for learning how to apply the technology on project 

specific situations. 

• Production Support Office | CADD (CADD) Website:  http://www.fdot.gov/cadd/ 

Webinar training recordings are available on many of the subjects covered in this manual:  

http://www.fdot.gov/cadd/main/FDOTCaddTraining.shtm 

http://www.fdot.gov/cadd/downloads/webinars/Posted.shtm#loadSection 

https://www.youtube.com/channel/UCqbY8kqZuXp1pyYV6lIQw_A 

https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/33435/openroads-designer
https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/33435/openroads-designer
http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-faqs.aspx
http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-faqs.aspx
https://learn.bentley.com/
http://www.bentley.com/
http://www.youtube.com/user/BentleyCivil
http://www.fdot.gov/cadd/
http://www.fdot.gov/cadd/main/FDOTCaddTraining.shtm
http://www.fdot.gov/cadd/downloads/webinars/Posted.shtm#loadSection
https://www.youtube.com/channel/UCqbY8kqZuXp1pyYV6lIQw_A
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COURSE SUPPORTING FILES 

The exercises for each chapter are independent of one another and can be used without having to complete the 

exercises in previous modules. The exercise files are organized into separate completed Selected zip files for each 

chapter.  All files used in this course are located also at this link: 

 

HTTPS://WWW.FDOT.GOV/CADD/MAIN/FDOTCADDTRAINI

NG.SHTMINTRODUCING A NEW WORKSPACE 

FDOTCONNECTXX.XX PREDEFINED SETTINGS 

 

DESIGN FILE SETTINGS: 
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FDOTCONNECTXX.XX WORKSPACE PREFERENCES: 
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FDOTCONNECTXX.XX FUNCTION KEYS  

FDOTCONNECTXX.XX Function Key Assignments 

F1 Opens the OpenRoads Designer OnLine Help. Ctrl+F1 Closes all Views except View 1 

F2 Open View 1 (2D Plan) and View 2 (3D Isometric) and fits both views. 

F3 Opens View 3 (2D Plan), closes all View 4, and arranges all Views. 

F4 Open View 1 (2D Plan), View 2 (3D Isometric), View 1 (2D Plan), View 1 (2D Plan) & 

Fits All views 

F5 Toggles Dim References ON/OFF 

F6 Resets out of any ongoing commands. 

F7 Toggles the Construction view attribute ON/OFF. 

F8 Toggles between MicroStation AccuDraw and Civil AccuDraw. 

F9 Toggles (opens or closes) the Reference dialog. 

F10 Toggles (opens or closes) the Level Display dialog. 

F11 Toggles (opens or closes) the Project Explorer dialog. 

F12 Opens the Create Template dialog. 
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• Function Key F1 – Civil Help 

 

  

• Function Key F2 – Open and Fits Two Views Setup; View 1- 2D Plan, View 2-Isometric 
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• Function Key F3 – Opens View 3; Closes View 4 and Arranges Views 

 

• Function Key F4 – Opens and fits Four View Setup; View 1- 2D Plan, View 2-Isometric, View 3,4 - custom 
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• Function Key F5 – Toggle Dim References 

  

• Function Key F6 – Resets Out of Any Ongoing Commands. 

 

• Function Key F7 – Toggles On/Off Construction View Attributes 

   

  



INTRODUCTION __________________________________________ Introducing a New WorkspaceIntroducing a New Workspace 

FDOT Roadway Design Existing Modeling  ©2021 FDOT  11 

• Function Key F8 – Toggles Between MicroStation AccuDraw and Civil AccuDraw 

  

• Function Key F9 – Toggles Reference Dialog Open\Close. 

 

• Function Key F10 – Toggles Level Display Dialog Open\Close. 
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• Function Key F11 Toggles Project Explorer Dialog Open/Close. 

  

• Function Key F12 Corridor Modeling, Opens Create Template Dialog. 
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FDOTCONNECTXX.XX USER CONFIGURATION VARIABLES 

  

FDOTCONNECTXX.XX DESIGN AND 3D MODELING OVERVIEW 
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GENERAL WORKFLOW AND CHAPTER OUTLINE 

1. Existing Terrain and Existing Features 

2. Export and Import Existing Ground   

3.  Existing and Proposed Right of Way LinesDesign. 

4. Existing Utilities Model 

5. Existing Drainage Model  

6. Existing Geotechnical Data. 

 

RECOMMENDED MICROSTATION SETTINGS 

Various tools and settings will be used throughout the workshop. Therefore, for quick accessibility, several of 

the dialogs are better docked on the sides the MicroStation view. 

GETTING STARTED 

LAUNCHING FDOTCONNECTXX.XX FOR OPENROADS DESIGNER 

FDOTConnectXX.XX can be launched from the FDOT  icons located in the FDOTConnectXX.XX folder 

on your desktop.  The first time it is launched, it is important to select the FDOT workspace from the 

workspace dropdown. 

1. Find the FDOTConnectXX.XX launch icons on your desktop or locate the 

“FDOTConnectXX.XX” folder on your desktop.  

  

2. Launch FDOTConnectXX.XX for OpenRoads Designer by double-clicking one of the FDOT 

icons. Note that your FDOTConnectXX.XX launch icons will vary depending on which 

Bentley Connect Edition platforms you have installed. FDOTConnectXX.XX will create an 

icon for OpenRoads Designer, an icon for Microstation Connect Edition (MSCE), and an 

icon for OpenBridge Modeler (OBM) depending on which of these applications is present on 

your machine during installation of the Workstation or Client. (This release of FDOT 

Connect is the “Alpha test” version for OpenBridge Modeler).  
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1. In the Workspace/Workset select screen of OpenRoads Designer, select the Workspace 

selection drop-down menu by clicking on “No Workspace.” 

 

2. Select “FDOT” from the drop-down menu to select the FDOTConnectXX.XX workspace. 

   

3. From here, you can now create a new WorkSet,this is done by selecting the drop-down 

menu, being sure to select the FDOT’s “0_WORKSET_TEMPLATE” as the workset template.  
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4. Click “OK” after filling in the Create Workset dialog. 

 

5. After creating a new project using the FDOT Workset Template, you can create new files using 

the FDOT Create File tool.  This tool is launched from within the FDOTConnectXX.XX 

workspace, so you must first open a file.  The FDOT Workset template includes a blank 

starting file from which to launch the Create File tool. 

6. From the OpenRoads Designer file open dialog, select “Browse” to browse the contents of 

your new workset. 

 

7. Locate “_Blankfile.dgn” at the root of your workset folder structure. Select this file and then 

select “OPEN” to open it. 
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8. When the FDOTConnectXX.XX Workspace opens, you can locate the FDOT ribbon by 

selecting the “OpenRoads Modeling” workflow from the menu at the top left of the screen. 

The FDOT tab is located at the far right of this ribbon.  Select “Create File” to launch the 

Create File tool for creating FDOT project files.  
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MENU DOCKING 

  

1. Verify that the Civil Message Center tool is already docked on the bottom; if not, select it from 

the General Geometry Task group, dock and unpin. 

   

2. Verify that the Project Explorer is docked on the left side; if not, from the Ribbon select the 

Home tab then in the group named primary click on the explorer icon…Or use the F11 function 

key to toggle ON/OFF the dialog. 
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3. Verify that the Level Display is docked on the right side; if not, from the FDOT-Function Keys 

press F10, dock and unpin. 

 

4. Verify that the Element Information is docked on the right side; if not, this can be brought up 

by selecting Ctrl+I, dock and unpin. 

  

• Many of the dialog settings are stored in user preferences defined in xml data files located in the user’s data 
folders i.e. C:\Users\rd964vd\AppData\Local\Bentley\OpenRoadsDesigner\10.0.0\prefs. 
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1 EXISTING FEATURES 

INTRODUCTION 

 This chapter will introduce the OpenRoads Technology tools to use for viewing the existing terrain and 

creating 3D existing features in design models in FDOTConnectXX.XX.  

CIVIL TERRAIN MODELING 

As defined in the Bentley Civil Tools help files: 

“A terrain model is a set of three-dimensional triangles mathematically computed from point 

data collected on the surface being modeled. Models are used to define highly irregular surfaces, 

particularly the surface of the earth, but can be generated for proposed surfaces, subsurface 

geotechnical layers, and etcetera. Terrain models are also referred to as digital terrain models 

(DTMs), triangulated irregular networks (TINs), or triangulated surfaces. 

The MicroStation Terrain Model tools support importing and labeling terrain contours and 

spots on terrain models. You can import a terrain model into a DGN to use its data. Terrain 

models imported from the LandXML file format are supported within MicroStation. However, 

any manipulation or importing from Civil products must be done within Bentley Civil. 

Bentley Civil provides a robust set of tools to create, edit, analyze, and work with terrain models. 

A terrain model is recognized as a MicroStation element type as of MicroStation V8i 

(SELECTseries 4). When you select a terrain model, the Element Selection tool Element Type 

tab indicates that it is a Terrain element type.” 

Several terrain model civil features have been developed for the FDOTConnectXX.XX Workspace to be used on 

FDOT projects. Terrain elements created in the design file can be selected from these features in the various 

Terrain Model Tasks. 

WORKFLOW INFORMATION 

The workflow process for getting existing features to appear on cross sections has changed significantly in 

FDOTConnectXX.XX.  No longer will the legacy existing features criteria be used.  Instead the existing features 

will be created in a 3D model following the steps outlined in the exercises to follow. 

• Levels containing the existing features will be identified from the SURVRD01 OR TOPORD01 file and 

copied into a MODLRD file. We recommend adding a modifier of ExistingFeatures or ExFeat to help keep 

track of model management. The GKLNRD file is being replaced by the MODLRD in the 

FDOTConnectXX.XX workflow. 

• Refer to the FDM Chapter 9.11 for description of a Model Management Plan 

• Closed shapes will be created to contain areas representing the existing features. These are the features which 

are typically required to be the on cross sections.  
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The Table 1.1 below is a list of the Levels that contain these features.  

    Table 1.1 

  Level Existing Feature 

CGBack_ep Curb Back Line 

CGep_ep Curb Edge of Pavement 

ConcSlabs_ep Concrete Slabs 

Driveway_ep Driveway Pavement 

PavtAsphalt_ep  Pavement (Roadway) 

PavtMisc_ep Pavement (Miscellaneous) 

ShldrPaved_ep Shoulder Pavement 

SidewalkFront_ep Sidewalk Front Line * 

SidewalkBack_ep Sidewalk Back Line 

TrafSeparator_ep Traffic Separator 

* A sidewalk front line may not be present when 

the sidewalk is adjacent to curb. 

 

• The existing Terrain will then be clipped by each shape individually to create separate existing feature 

Terrains. 

• A surface template is then applied to the terrain features to define the sub-surface depth to the terrain. 

• For the non-uniform depth curb and gutter, a linear template is applied. 

• A profile is added to the R/W Existing lines in order to display the R/W line symbol in a cross section view. 

When finished, the file will contain 3D existing features developed from the original existing DTM terrain and 

SURVRD01 files. As a result of creating this file, any cross section created while the terrain elements are 

displayed in the 3D model will show existing features below the surface. 

 EXERCISE OVERVIEW 

Exercise 1.1 Create and Set Up the MODLRD file ....................................................... Error! Bookmark not defined. 
Exercise 1.2 Create Shapes Using FDOT Create Existing Features .............................. Error! Bookmark not defined. 
Exercise 1.3 Create Existing Feature Terrains (External) ............................................ Error! Bookmark not defined. 
Exercise 1.4 Creating a 3D Terrain Model Boundary by Active Profile ....................... Error! Bookmark not defined. 
Exercise 1.5 Clip Terrains within Terrain, i.e. Medians/Traffic Separators ................. Error! Bookmark not defined. 
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Exercise 1.1 Create and Set Up the MODLRD file 

In this exercise, the MODLRD_ExistingFeatures01.dgn file will be created using the Create File tool 

found in the FDOT Tab of the Ribbon and the Create Existing Features tool will be used to reference the 

SURVRD01 file which contains the existing survey.    

1. From the desktop FDOTConnectXX.XX folder, double-click on the FDOTConnectXX.XX 

for OpenRoads Designer icon. 

 

 

2. Open the _BlankFile.dgn for the current workset that was delivered or any dgn file with in 

the 22049555201_CE workset. 

3. Navigate to FDOT Ribbon Tab of the OpenRoads Modeling WorkFlow looking for the 

Actions Group click on the create file. 

OPENROADS MODELING>FDOT>ACTIONS>Create File. 

4. Create a MODLRD_ExistingFeatures01.dgn file with the dialog as shown below. 

   

a. Set the Discipline to Roadway, File Group to Roadway Design Files. 

b. Then select  the Base Filename of MODLRD 

c. Keyin _Existing Features in the Modifier(Optional) Field and leave the File Sequnce 

# as 01. 

d. Select the project County, selecting this will set the correct coordinate system  
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e. Click Create - Open File to create the file, MODLRD_ExistingFeatures.dgn. 

f. You are now in the MODLRD_ExistingFeatures Click Close.  

 
5. From the FDOT TAB in the Ribbon navigate to the Roadway Group, select the Create Existing 

Features icon. 

 

 

6. A message dialog will pop up asking for a survey file to be attached. Click OK. A new 

window will open to the SURVEY Folder in the current Workset. Select the 

SURVRD01.dgn file . 

 

7. Click Open.  FDOT Features 1.0.3.2 opens.  (The tool has attached the SURVRD file as a 

reference, and copied in the elements on levels from Table 1.1, and then turned off the 

display to the reference file.)Notice the Existing Ground boundary element is  
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8. Turn on the display for the referenced SURVRD01 file. 

9. Turn off all the levels in the reference SURVRD01 file except the DTM_ex. 

10. Select MicroStation Fit View to see the elements copied into the file 
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Exercise 1.2 Create Shapes Using FDOT Create Existing Features   

 

The FDOT Features tool will be used to assist in closing areas and creating the necessary shapes for 

the existing features to be modeled. The tool contains a drop-down menu and 3 tool icons.  The drop-

down menu allows for the selection of the active existing feature.  Levels are turned on/off to help 

isolate the areas where shapes are needed.  In order to create a continuous shape around the existing 

features, miscellaneous lines are drawn in the file at various locations.  The first icon, Place Feature 

Line, activates the Place Feature Line tool.  The second and third icons are used to create the shapes 

either by the flood method or by selecting the elements to trace. 

Note When the “Create Existing Features” tool is used and the Survey (SURVRDxx.dgn) is attached, the 
survey is automatically displayed with only the DTM_ex level on. 

1. On the FDOT Features dialog, select Pavement from the dropdown list. 

 

2. Select Place Feature Line and place lines to separate the 2 existing roadways and close off the 

pavement areas as shown. 
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Note The lines drawn to close the turnouts (purple) beyond the RW line can be used to create shapes for either 
Turn Out or Pavement depending on preference. 

3. Select the icon Create Feature Shape by Flood.  

   

4. Left-Click (Data Point) inside each area defined with step 2 to create the required shapes.  The 

tool will highlight and zoom the area to fit the view before accepting each shape. Left-Click 

(Data Point) again in the screen to accept.  Zooming out to see the entire shape before selecting 

inside an area is not necessary. 
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5. Repeat the steps to create closed shapes for each of the following types of features. 

Note Place lines to close line work differentiating existing features. It may be necessary to modify the Tolerance 
value when creating the shapes.  The Flood Feature Tolerance dialog box will pop up when the Create 
Feature Shape by Flood tool is activated. 

Existing Features Types: 

Shoulders 

Driveways, 

Existing Traffic Separator 

Turnouts 

Side Streets 

Medians 

(CGFace_ep and CGBack_ep elements will be used in later exercises.) 

Note This exercise is meant to demonstrate the procedures for adding existing features into a 3D model. There 
may be more features on a typical project and the steps outlined here can be used to achieve the desired 
results. 

6. Close the FDOT Features Tool and then close FDOTConnectXX.XX for OpenRoads 

Designer before continuing to Exercise 1.3. 
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Exercise 1.3 Create Existing Feature Terrains (External) 

Once the shapes are created, those shapes can be used to create individual terrains from the existing 

DTM.  This is referred to as External Clipping.  In this exercise, the Open Roads Civil tool, Clip 

Terrains will be used to create the terrains for the pavement, shoulders, driveways, and turnouts. 

In Table 1.3 below the FDOTConnectXX.XX Workspace has Feature Definitions for the 

Terrain Elements for Existing Feature 

 

Table 1.3 

FEATURE DEFINITONS Feature Name 

DtmExistingFeatureDriveway Ex_FeatureDriveway 

DtmExistingFeaturePavement ExFeatureEX61_Pavement 

DtmExistingFeaturePavedShldr Paved Shoulder Shapes 

DtmExistingFeatureSidewalk Sidewalk Shapes 

DtmExistingFeatureTraffSep Traffic Separator Shapes 

  

  

 

1. Open up the MicroStation file 

C:\Worksets\FDOT\\22049555201_CE\Roadway\MODLRD_ExistingFeatures01.dgn. 

a. Set the Active Level to PavtAsphalt_ep and turn Off all the other Used Levels.  

b. Make sure the Reference file display for the Terrain is turned On. 

2. In the Terrain Tab of the Ribbon navigate to the Create Group use the “Additional Methods” 

drop down to find the “Create Clipped Terrain Model” tool.  Use this tool to create an 

“External” Terrain Model of the shape that was created above. 

OPENROADS MODELING>TERRAIN>CREATE>Additional Methods>Create Clipped 

Terrain Model 
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Note Once the Clipped Terrain Model tool has been used it will be the default tool until another is used. 

Note If you did not close the file when completing Exercise 1.2 and the file crashes when activating this tool, use 
Clear Crash to close the OpenRoads Designer session.  Reopen the file and start this exercise from step 
1. 

3. On the Create Clipped Terrain Models dialog, under the Feature section set the Feature 

Definition to DtmExistingFeaturePavement and enter ExFeature_SR61_Pavement for the 

Name. 

a. FDOTConnectXX.XX

a. Following the prompts on the end of the cursor, locate the Reference Terrain Model 

element. This will be the terrain you are clipping from, which in most cases will be 

the Existing Terrain Model. Select the Existing Ground boundary as the Reference 

Terrain. 

 

 

b. Locate the Clipping Element; the shape for which you want to create a terrain. Select 

the shape created for the left existing pavement for SR 61 and Left-Click (Data Point) 

to accept it as the Clipping Element.  

Note Some of the shapes may overlap each other. Right-click or Tab through the shapes and 
select the correct one. Select F6 to exit the command and then restart the command if 
needed.  

c. Right click to Reset when finished to stop selecting Clipping Elements.  

d. Set the Horizontal Offset to 0.0 and Left-Click (Data Point) to accept. 
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e. Set the Vertical Offset to 0.0 and Left-Click (Data Point) to accept.  

f. Set the Clipping Method to External and Left-Click (Data Point) to accept. 

Note When selecting multiple shapes, the dialog will flip and lock to the internal method. External boundaries 
can only be selected one boundary at a time. 

Internal clipping elements will be added in another exercise. 

4. Repeat step 3 to create the terrain for the right side of SR61.  The tool will automatically 

rename the terrain by adding a 1 to the end.  (Notice that the triangle for the right side of SR61 

are triangulating outside of the boundary.) 

 

5. A clipped terrain is created and placed in the 3D Model of the default 3D of the active file. 

The 3D Model is then referenced to the 2D Model.  To Edit a terrain, it must be done in the 

3D model.  Select the Function Key F2 to open both the 2D and the 3D Model. 
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Exercise 1.4 (Optional) Creating a 3D Terrain Model Boundary by Active Profile 

1. Set the parent Terrain Model (Existing Ground) to the active Terrain Model by selecting hovering over the 

boundary of the Terrain Model to open the contextual menu.  Select “Set as Active Terrain Model”. 

 

2. Select the 2D Clipping Element and hover to get the contextual menu.  Click on “Open Profile Model”. 
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3. Open a new view to display the profile model and Left-Click (Data Point) in the new view to visualize the 

profile. 

 

4. In the new view, select the profile and hover to show the contextual menu.  Click on the “Set As Active 

Profile” tool.  Setting the Active Profile creates a 3D boundary out of the 2D Clipping Element. 

 



Chapter 1 _____________________________________________________________ EXISTING FEATURES - Exercise Overview 

1-14 ©2021 FDOT  FDOT Roadway Design Existing Modeling 

5. Close the profile view.  You are now ready to add the newly created 3D boundary to the clipped Terrain 

Model (SR61-Temp) as a Boundary Feature. 

6. In the Terrain Model Ribbon tab in the Edit group, select the Feature Management drop down and click 

on the “Add Features” tool. 

 

7. Locate the Clipped Terrain Model (SR61-Temp) to Add Elements.  Locate the newly created 3D boundary 

as the “Element to Add”.  Set the Feature Type to “Boundary” and Left-Click (Data Point) in the view. 
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8. Adding the 3D boundary to the Terrain Model has constrained the triangles to inside the Clipping Element. 

NOTE:  The Edge Method for this Terrain Model is now defined as “From Boundary”. 

 

9. Select the SR61-Temp Terrain Model and in the Properties Dialogue box, turn off triangles. 
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Exercise 1.5 Clip Terrains within Terrain, i.e. Medians/Traffic Separators 

In some cases, the terrain created may include areas that they should not.  Examples include Traffic 

Separator, Medians, or Curbed Islands within a terrain created for a pavement area.  These smaller 

sections need to be clipped out of the larger terrain.  This is referred to as Internal Clipping.  The tool 

creates a new terrain with the area(s) clipped out.  It does not modify the existing terrain or the original 

terrain. 

In this exercise, a terrain will be created using the internal method for the pavement terrain created in 

the previous exercise on the right side of SR 61. 

1. Select the Terrain ExFeature_SR61_Pavement, and hover over the boundary to display the 

Context Menu. Select the Properties dialog. 

  

2. From the Properties dialog, set the Triangles option to Off. 
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3. Use the Terrain Tab to select the Create Clipped Terrain tool to create a clip boundary within 

a terrain for Existing Features. This tool can be found on the OpenRoads Modeling workflow, 

then in the Terrain Tab of the Ribbon find the Create Group in the Additional Methods drop 

down can be found Create Clipped Terrain Model tool. 

OPENROADS MODELING>TERRAIN>Create>Additional Methods>Create Clipped 

Terrain Model 

  

a. On the Create Clipped Terrain Models dialog, select the Reference Terrain Model 

ExFeature_SR61_Pavement1. 

b. Enter the Name ExFeature_SR61_Pavment2. 

c. Then locate the shape inside the ExFeature_SR61_Pavement1 boundary.  

d. Reset when finished. 
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 Multiple internal clipping elements can be added one time.  

e. Change the Clipping Method to Internal. 

f. Left-Click (Data Point) to create the clipped Terrain.   

4. To delete the first ExFeature_SR61_Pavement1 Terrain. 

a. Select F11 to launch Project Explorer. 

b. Select the OpenRoads Model tab. 

c. Navigate to the MODLRD_ExistingFeatures01.DGN, Default > Terrain Models folder 

then Navigate to the DtmExistingPavement Feature and select the terrain model to 

delete. 

d. Right-click on the Terrain Model: ExFeature_SR61_Pavement1 and select Delete.  
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Exercise 1.6 Create Existing Traffic Separator Terrains 

In the previous exercise, the Existing Pavement Terrain area has been created for 

ExFeature_US98_Pavement, now the Existing Traffic Separator Terrain can be created. 

1. On the reference dialog, turn off the Display for the Default 3D model.  (This will make it 

easier to select the traffic separator shape.) 

2. . Use the Terrain Tab to select the Create Clipped Terrain tool to create a clip boundary within 

a terrain for Existing Features. This tool can be found on the OpenRoads Modeling workflow, 

then in the Terrain Tab of the Ribbon find the Create Group in the Additional Methods drop 

down can be found Create Clipped Terrain Model tool. 

OPENROADS MODELING>TERRAIN>Create>Additional Methods>Create Clipped 

Terrain Model 

3.  

  

4. On the Create Clipped Terrain Models dialog, select the Reference Terrain Model 

Existing Ground. 

5. Set the Clipping Method to External. 

6. Set the Feature Definition to DtmExistingFeatureTraffSep.  

7. Enter ExFeatureTraffSep_US98-1 for the Name. 

  

8. Select the Traffic Separator Island Shape. 
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Note The curb islands will be created in exercises to follow using linear templates. 

9. Turn back on the display for the Default 3D model to see the terrain triangles. 
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Exercise 1.7  Apply Surface Templates 

In this exercise the Surface Template will be applied to each of the existing terrains created from the 

previous exercises.  

1. On the OpenRoads Modeling workflow switch to the Corridor TAb from there find the Create 

Group select the Template Drop down menu select Create Template to bring up the itl dialog 

to view the FDOT surface Templates.  

 

 

a. The Create Template dialog displays the current workset .itl file.   

b. Navigate the left folders to the Existing Feature Templates folder. 

  



EXISTING FEATURES - Exercise Overview _____________________________________________________________ Chapter 1 

FDOT Roadway Design Existing Modeling  ©2021 FDOT  1-23 

c. Double click on PavementAsphaltExisting. (This is an example of the template to be 

used for the existing pavement.) 

 

d. Click Close to exit the dialog. 

2. On the OpenRoads Modeling workflow switch to the Model Detailing Tab from there find 

the 3D Tools Group select the, Apply Surface Template tool to apply a surface template to 

each Clipped Terrain 

 

a. The first step is to pick the Template PavementAsphaltExisting from the drop down 

list.. Now the Feature Definitionneeds to be set. Set this to Enable Linear Features. 
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Following the prompts on the end of the cursor, locate the Terrain Model and select 

the ExFeature_SR61_Pavement Terrain. 

 

b. Set the Apply External Clip Boundary to No. (The arrow keys on the keyboard can be 

used to toggle through the options.) 

 

c. Left-Click (Data Point) to accept. 

d. Set the General Template to PavementAsphaltExisting.  

 

• The Template library can be opened by Selecting Alt+↓ on the keyboard. 

e. Left-Click (Data Point) to accept that template.  A surface will be applied to that 

terrain with the correct feature. 
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3. Repeat this procedure for each of the Existing Feature Terrains shown in the Table 1.7 below. 

 

            Table 1.7 

 Existing Feature Terrain Name Existing Feature Template 

ExFeature_SR61_Pavement2   PavementAsphaltExisting  

ExFeature_SR61_Shoulder(s)  PavedShldrExisting  

ExFeature_US98_Pavement(s)  PavementAsphaltExisting  

ExFeature_US98_Driveway(s)  DrivewayExisting  

ExFeature_US98_Shoulder(s)  PavedShldrExisting  

ExFeature_US98_TrafficSeparator  TrafficSepExisting  

ExFeature_US98_Turnout(s)  PavedAsphaltExisting  

4. To view those Existing Features created in the 3D Model without the Existing Feature 

Terrain triangles, click F11 to open Explorer, then navigate to OpenRoads Standards > 

MODLRD_ExistingFeatures01.dgn, Default > Feature Definitions > Terrain and toggle OFF 

either the Terrain Display or DtmExistingFeaturePavement option. 
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Exercise 1.8 Edit Existing Feature Depth  

The surface templates that have been applied are set with a default depth.  In many cases, these depths 

may be acceptable.  If not, they will need to be edited.   

1. Click F2 to open the views showing both the 2D and 3D models. 

2. Select the 3D view to make it active.  (A dialog will pop up asking to accept settings.  This is 

due to the Survey attached to the file.  Click on the X to close the dialog.) 

3.  On the OpenRoads Modeling workflow switch to the Model Detailing Tab from there find 

the 3D Tools Group select the Edit An Applied Surface Template icon. 

 

4. In the 3D view, select one of the surface templates. The Editing Roadway Design Template 

Drop dialog (the interface is identical to the Template Library dialog) opens with the current 

template shown with the Library tab active.  

 

5. Click on the Active Template tab. 
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6. On the left-hand menu, navigate to the Parametric Constraints folder and double click on the 

EOP_PvtThick item. 

 

7. Set the Default Value to -.5 and click OK. 

  

8. Click OK to close the Editing Roadway Designer Template Drop dialog. You do not have 

to select File > Save to save your edits. 

Note Another Option is to open Explorer and navigate to the Terrain’s surface template and right click to choose 
Edit and Applied Surface Template. 
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Exercise 1.9 Add Curbs to the Existing Features 

In this exercise a model of the existing curbs will be developed. In order to use the Civil Tools to create 

the Existing Curb Model, MicroStation elements will need to be changed to Civil Features.  Linear 

templates will then be applied to the feature elements to generate the depth needed for curbs. 

1. Select Ctrl + F1 to return to a One View only of the project. 

2. Select the Existing Terrain Boundary, and when the Context Menu displays, click on the Set 

As Active Terrain Model. (This will allow for profiles to be displayed on elements.)  

 

3. In the Level Display dialog, right click on the Ref, MODLRD_ExistingFeatures01.dgn, 

default-3D file and Uncheck the display. 

4. In the Level Display dialog, click on MODLRD_ExistingFeatures01.dgn, default file, set the 

Active Level to CG_ep, and turn OFF all other Levels except for CGBack_ep and 

PavtAsphalt_ep. 
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5. Create a Selection of the median shapes made from the Back of Curb (level CGBack_ep) 

elements. 

 

a. Use the Set Feature Definition Tool to set the Back of Curb shapes to the Civil 

Roadway Feature, CurbExisting. This tool can be found in the OpenRoads Modeling 

workflow.  

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Standards>Set 

Feature Definition 

 

b. On the Set Feature Definition dialog, set the Feature Type to Linear and navigate 

the Feature Definition to Roadway Design>Plan/Profile 2D Lines>Curb > 

CurbExisting. The Name will automatically populate. 
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c. Left-Click (Data Point) to apply Feature to the selected elements.  

6. In an open area of the view (no elements) selected, use the right click menu option to select 

All On Level By Element.  Click on one of the edges of pavement shapes to create a Selection 

of the median shapes made from the Existing Pavement (PavtAsphalt_ep) elements. 

a. Use the Existing Features, Set Feature Definition to set the Existing Pavement 

(PavtAsphalt_ep) shapes to the Civil Roadway Feature, PavementExisting.  

  

b. On the Set Feature Definition dialog, navigate to the Feature Definition to 

Roadway Design>Plan/Profile 2D Lines>Pavement>PavementExisting. The Name 

will automatically populate. 

 

c. Left-Click (Data Point) to apply Feature to the selected elements.  

➢ Open Profile Model for Back of Curb. 

 

7. Select the Back of Curb shape and hover over the highlighted line until the Popup Menu 

displays. 
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8. Select the Open Profile Model icon and select View 3 at the bottom of the MicroStation 

window to open the Profile view, then Left-Click (Data Point) inside View 3. 

 
9. In the Profile view, select the Existing Ground Profile to display the Popup Menu and then 

select the Set Active Profile icon. Close the Profile view window.  
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➢ Appling an Existing Curb Template  

1. Use the Apply Linear Template to create a 3D Existing Curb Feature. This tool can be 

found in the Ribbon on the OpenRoads Modeling workflow navigate to the Model Detailing 

Tab, then the 3D Tools Group 

OPENROADS MODELING>MODEL DETAILING>3D TOOLS>Apply Linear Template 

 

 

 

a. At the prompt, locate element and select the CurbExisting Feature (i.e. back of curb 

line). 

b. Hold Alt down arrow key to pick the CurbExisting Template. 

 

c. Click Ok and then Left-Click (Data Point) to accept. 

d. Press the Alt key to lock the Start and then Left-Click (Data Point). Press the Alt key 

to lock the End, and then Left-Click (Data Point) again. 
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e. Select the side to place the curb and Left-Click (Data Point) outward from the back 

of curb.  

f. Enter (<OR> accept) 1 degree for the Exterior Corner Sweep Angle. 

g. Enter Existing Curb for the Description.  Left-Click (Data Point) to accept. 

2. Select the F2 Function Key to open the 3D model View. The 3D Curb bottom shape will appear 

in the model.  

  

3. Switch back to the Corridors Tab to use the Add Corridor Reference tool to add the 

Template Target Feature, PavementExisting, to the CurbExisting Template. This can be 

found in the Corridors Tab from this Tab navigate to the Miscellaneous Group select on the 

drop-down menu Corridor References there find Add Corridor References   

OPENROADS MODELING>CORRIDORS>MISCELLANEOUS>Corridor 

References>Add Corridor References 

 

 

a. At the prompt, select the CurbExisting corridor boundary element handle on level 

CorrHndlStg3_dp. 

b. Select the PavementExisting line in front of the CurbExisting Feature. 

c. Click F6 to end the command. 

Note The Existing curb in the 3D model should stretch from the back to the edge of pavement as shown in the 
image below. 
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.  
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Exercise 1.10 View Existing Cross Sections 

Once the Existing Feature Terrains have been created a cross section view can be created to verify the 

model data.  In this exercise a base line in the ALGNRD reference file will be used to create a cross 

section view.  

1. Use Reference Display to display the attached ALGNRD01.dgn file. This file has the Survey 

Baseline elements displayed to use for cross sections. 

The Open Cross Section View Tool can be found on the Corridor Tab of the Ribbon, 

navigate to the Review Group select on the Drop down for Dynamic Sections and then pick 

Open Cross Section View  

OPENROADS MODELING>CORRIDORS>REVIEW>Dynamic Sections>Open Cross 

Section View 

  

 

2. At the prompt, select the Baseline element shown below. Then select or open a view where the 

Cross Section will be displayed. 
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3. Enter information in the dialog as shown:   

Note  Be sure to check the Station box or the Program may crash!  

 

4. Left-Click (Data Point) in the view to accept EACH of the settings from above. 

5. Open View 4 and Left-Click (Data Point) in the view to display the Cross Section. 

 

6. For the Cross Section in View 4: 

a. Notice many of the MicroStation Zoom, Pan, etc. commands will operate as normal.  

b. Use the Cross-Section View Navigation tools to examine the Existing Features. 

  

c. Select View Properties and set the Vertical Exaggeration to 10 and then select the 

View to see the changes. 
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d. Select the Station pull down menu and change to Station 2+20, (i.e. key in 220 and 

Enter). 

 

7. Navigate the cross-section stations and notice the blue line in the plan view designating the 

current cross section view station. 

Note This line will also appear in View 1which has the Baseline. 
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2 CREATING A GDTMRD FILE 

INTRODUCTION 

This course was developed to introduce OpenRoads Designer CONNECT Edition - OpenRoads Technology tools 

for design and modeling on Florida Department of Transportation (FDOT) projects.  The curriculum was 

developed within the FDOTCONNECTXX.XX Workspace to provide sample exercises for most of the new Civil 

Tools on a sample project data set. 

OBJECTIVE 

This chapter will introduce the OpenRoads Technology tools that will be used for to export and import the 

Existing Ground Terrain from the SURVRD file into a GDTMRD file that can be used for future Modeling. 

EXERCISE OVERVIEW 

Exercise 2.1 Creating a GDTMRD01.dgn ..................................................................... Error! Bookmark not defined. 
Exercise 2.2 Export the Existing Ground by Boundary ................................................ Error! Bookmark not defined. 
Exercise 2.3 Importing the Existing Ground Landxml ................................................. Error! Bookmark not defined. 
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Exercise 2.1 Creating a GDTMRD01.dgn  

1. Open the _BlankFile.dgn for the current workset that was delivered or any dgn file with in the 

22049555201_CE workset. 

2. Navigate to the FDOT Tab on the Ribbon, from the Actions Group select the Create File tool to launch the 

Application. 

OPENROADS MODELING>FDOT>ACTIONS>Create File. 

 

3  Switch the Discipline to SURVEY and the File Group to Survey Design Files. Select then Base file 

name of GDTMRD. 

 

 

4. Close the Create file Dialog. 
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Exercise 2.2 Export the Existing Ground by Boundary  

1. Open the Reference Dialog by pressing F9 function keys. Attach the SURVRD file. Fit view 

to see the SURVRD file. 

 

2. Zoom into the Terrain boundary element, select the Terrain Boundary element. Be sure to 

select the element with the Level of DTM_ex.not the DTM_ep level. 

3. Hover over the boundary to bring up the context menu. The third option in the context menu 

will allow the export to choose the option Landxml 
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4. Follow the prompts filling out information as necesarry  

a. Project Name: - Wakulla 

b. Project Description: - Wakulla SR 61 

c. Export Options: Export Both 

 

d.The Export terrain dialog will open to the Survey folder save the file as Existing Ground.xml  
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Exercise 2.3 Importing the Existing Ground Landxml 

1. Detach the SURVRD file from the reference dialog. 

 
2. Switch to the Terrain Tab on the OpenRoads Modeling workflow, navigate to the Create Group selct the 

tool From File 

OPENROADS MODELING>TERRAIN>CREATE>From File 
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3. This will search for the Existing Ground.xml that was saved in the Survey foler. Select this file. Once 

selected click Done. 

 
4. This will open the Import Terrain model Dialog. Check to see that the Feature Definition is set to 

DTMExisting. Once set click the import button. 
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5. Close the Import Terrain Model Dialog, then fit the view to see the existing ground boundary. 
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3 EXISTING ROW LINES 

INTRODUCTION 

These exercises will introduce the user the process of bringing in the Existing ROW lines into the MODLRD 

File. This will be done so that ROW cells will show in the different Cross Sections. 

OBJECTIVE 

• Create a RWDTRD file. 

• Copy in ROWLines_ep and RWLines. 

• Set Feature Definition for Existing ROW Lines 

• Set Active Profile to the Right of Way Lines in order to display the R/W line symbol in a cross 

section view. 

• View the ROW Cells in Dynamic Cross Section Views 

EXERCISE OVERVIEW 

Exercise 3.1 Create a RWDTRD file for ROW Lines. .................................................... Error! Bookmark not defined. 
Exercise 3.2 Copy the Existing and Proposed ROW Lines into the RWDTRD file ........ Error! Bookmark not defined. 
Exercise 3.3 Steps to create Roadway Right of Way Features .................................... Error! Bookmark not defined. 
Exercise 3.4 Add the Existing Ground for Profile ........................................................ Error! Bookmark not defined. 
Exercise 3.5 Adding the Existing Ground for a Profile ................................................ Error! Bookmark not defined. 
Exercise 3.6 View ROW Lines in a Dynamic Cross Section .......................................... Error! Bookmark not defined. 
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Exercise 3.1 Create a RWDTRD file for ROW Lines.  

1. Open the _BlankFile.dgn for the current workset that was delivered or any dgn file within the 

22049555201_CE workset. 

2. Navigate to the FDOT Tab on the Ribbon, from the Actions Group select the Create File tool to launch 

the Application. 

OPENROADS MODELING>FDOT>ACTIONS>Create File. 

 

3. From the Create File Tool Dialog make sure that the Roadway Discipline is set. The File Group 

is set to Roadway Design Files. Select the Base Filename of RWDTRD once selected click the 

Create – Open File button. This will create the file. 

 

 

4. Once the RWDTRD is created, close the Create File Tool  
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Exercise 3.2 Copy the Existing and Proposed ROW Lines into the 

RWDTRD file 

Note Verify the file where the ROW Lines are in(SURVRD) if not in the SURVRD then the RW#######XX.dgn 
file. The process in Exercise 3.2 will work for either scenario. Levels of ROW Lines FOR Existing 
ROWLine_ep for Proposed ROWLine 

1. Attach the RW220495501.dgn file using the reference dialog. Navigate to the ROWMap 

folder within the workset to find the file. Be sure to give a logical name of ROW. 

 

 

2. Fit view the screen to see the project. From the FDOT Tab navigate to the Actions Group, 

then in the Misc. Tools drop down select the Copy Reference Tool 

OPENROADS MODELING>FDOT>ACTIONS>Copy Reference Tool
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3. Using the Copy Reference Tool, in the left window scroll down to find the two levels of 

ROW “RWLine” and ROW “RWLine_ep”. Once selected click the green plus to add to the 

right, then click the process button. This tool will copy the two levels that were selected into 

the file. 

 

 

 

4. Verify that the RWLine and RWLine_ep levels and elements have been copied in to the file. 

 

 

  



EXISTING ROW LINES - Exercise Overview _____________________________________________________________ Chapter 3 

FDOT Roadway Design Existing Modeling  ©2021 FDOT  3-51 

 

Exercise 3.3 Steps to create Roadway Right of Way Features 

Note There will be two main steps in the process of converting the ROW lines (RWLine_EP and RWLine) to 
features. First a complex chain is created and then a Feature Definition is set. This exercise will break 
down those steps. 

1. Switch the workflow from OpenRoads Modeling to Drawing to bring a new set of tools to 

focus. Once on the Drawing workflow navigate to the Home Tab at the end of the home Tab 

find the Groups Group. Within this group select the Create Complex Chain tool. 

DRAWING>HOME>GROUPS>Create Complex Chain 

 

2. Set the Active Level to RWLine_ep. This can be done from the Modify Group select the Smart 

match tool then select one of the Existing Right of Way lines. 

 

Note This will be easier if you isolate the RWLine_ep Level by turning off RWLine level  
Review the ROW lines to minimize gaps between elements this will help when using the Complex Chain 
tool. 
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3. Set the Create Complex Chain Method to Automatic, set the Maximum Gap to 0.1 and chain 

together the RWLines_ep in the active file within the project Existing Terrain Limits. 

 

4. Repeat the process for the Proposed Right of Way Lines RWLine levels 

5. Once all the Right if Way lines are complex, the correct feature Definition will now need to 

be set. 

6. To set the Feature Definition switch back to the OpenRoads Modeling workflow navigate to 

the Geometry Tab, then to the General Tools Group select the Standards drop down to locate 

the Set Feature Definition Tool 
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7. Create a selection set of the RWLine_ep elements. This can be done by the right click 

function on the mouse. Once all the RWLine_ep elements are selected navigate to the Set 

Feature Definition Tool. Set the Feature Type to Linear then select from the list Right of 

Way Existing. Once the Feature is set Left-Click (Data Point) to complete 

 

Linear>Roadway Design>Plan/Profile 2D Lines>RightofWayItems>Right of Way Existing  

 

 

8. Repeat the step for the RWLine elements this time the Feature Definition is set to Right of 

Way Proposed 
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Exercise 3.4 Add the Existing Ground for Profile 

1. Now that the RWDTRD file is created the Existing Ground file (GDTMRD01.dgn) will be added as a 

reference file. This can be done by opening the reference dialog by the function key (F9) or from the 

HOME Tab in the PRIMARY Group Attach Tools 

OPENROADS MODELING>HOME>PRIMARY>Attach Tools 

 
2. Once the Reference Dialog is open click the attach button. Navigate to the Survey folder in the Workset 

and select the GDTMRD01.dgn file and attach, be sure to use a logical Name of GDTM. 
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3. Once the GDTMRD01 file is attached, a fit view is used to see the boundary of the existing Ground 

 
4. Now a 3D Model needs to be created for later use. To do this step select the boundary of the Existing 

terrain, then hover over the element to bring up the context menu select he second icon in the list which is 

Set As Active Terrain Model 

 
5. This will create a 3D model with in the RWDTRD file as a reference. 
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6. To view the New 3D model, use the right click function to bring the View Control options from the list 

select the 2 Views Plan/3D option this will setup two views on for plan and the Default 3D 

 
7. Now Save Settings this will save the plan and 3D default as the main views. 
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Exercise 3.5 Adding the Existing Ground for a Profile 

1. The next step is to add a profile to the Right of way Lines. But first let’s set up the views that 

we will be using. To do this use the right click View Control and select 3 Views 

Plan/Profile/3D. This will setup the views and ask to locate an element for profile select a 

RWLine_ep element then click in open view. Follow prompts. 

 

 

2. Next set the feature definition to Right of Way Existing by using the Feature Definition 

Toolbar. Click the Match Feature Definition select a Right of Way Existing, then click the 

Use Active Feature Definition. 

 

3. In the profile view click the existing ground element then hover over to display the context 

menu to Set As Active Profile 

 

4. Repeat these steps for the Right of Way Proposed Lines. 
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Exercise 3.6 View ROW Lines in a Dynamic Cross Section 

Note In order to see the Right of Way lines in the Dynamic Cross Section a temporary Corridor needs to be 
added.  

OPENROADS MODELING>CORRIDORS>CREATE>New Corridor.  

1. First Reference in the ALGNRD01.dgn file Be sure to set a Logical name of ALGN in when 

attaching. 

2. Once the Alignment file is referenced in let’s select the BaseLine of US98 to add a corridor to 

 

3. Right click to accept the active Profile. The default name will be the name of the Alignment. The 

next step is to select the template that you would like to place on the Corridor. Select the ellipses 

to select the XS Existing Feature Template that is located in the Existing Features Template folder 

in the itl file. In the Create Template drop Dialog select the Lock to start a Lock to End Check 

Boxes 

 

b. Once these parameters are set Left-Click (Data Point) in space in view 1 
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4. To view a Dynamic Cross Section from a Corridor. In the OpenRoads Modeling workflow 

select the Corridors Tab, from find the Review Group select the Dynamic Sections drop down 

menu select the Open Cross Section View tool. 

OPENROADS MODELING>CORRIDORS>REVIEW>Dynamic Sections>Open Cross 

Section View 

 

5.  Following the prompts of dialog select the Handle of the Corridor, then open view 4 and Left-

Click (Data Point) in the window. The cross section will appear as below. 
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4 EXISTING UTILITIES MODELING 

INTRODUCTION 

These exercises will introduce a new ORD Workflow (Menu) that will be used to layout existing Utilities lines. 

The Drainage and Utilities workflow in OpenRoads Designer will be used. When using the Drainage and Utilities 

workflow a SUDA and SUE database will be introduced into the file 

A new MODLRD file will be created and the optional modifier from the Create File Tool will designate it as 

the file for Existing Utilities (i.e. MODLRD_ExistingUtilites.dgn). Elements will be extracted from 2D 

elements and given Features for 3D. This will be done in order to see Existing Utilities in the 3D Model and 

then can be seen in Cross Sections View. 

 

OBJECTIVE 

Show Workflow of Creating the Existing Utilities 

Create a 3D Existing Utility Model 

Extract from Graphics Tool  

EXERCISE OVERVIEW 

Exercise 4.1 Creating an Existing Utilities Model File ................................................. Error! Bookmark not defined. 
Exercise 4.2 Referencing the GDTMRD and SURVRD .................................................. Error! Bookmark not defined. 
Exercise 4.3 Using the Extract from Graphics Tool ..................................................... Error! Bookmark not defined. 
Exercise 4.4 Show Existing Utilities in a Dynamic Cross Section ................................. Error! Bookmark not defined. 
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Exercise 4.1 Creating an Existing Utilities Model File 

1. Open the _BlankFile.dgn for the current workset that was delivered or any dgn file within the 

22049555201_CE workset. 

2. Navigate to the FDOT Tab on the Ribbon, from the Actions Group select the Create File tool to launch the 

Application. 

OPERNRAODS MODELING>FDOT>ACTIONS>Create File. 

 

3. From the Create Tool Dialog make sure to be working in the Roadway Discipline and choose the File 

Group Roadway Design Files. Now select the MODLRD Filename from the list, using the Modifier 

(Optional) box Fill out _ExistingUtilities to help designate what this file will be used for.  

 

4. Click the Create – Open File the MODLRD_ExistingUtilites01.dgn will be created, close the Create File 

Tool dialog. Select the Close button 
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5. Once the file opens change the workflow from OpenRoads Modeling to Drainage and Utilities. Then 

switch to the Layout Tab and select the Place Node Tool. A message window will pop up (You Cannot 

Undo This Action) click the yes button to proceed. 

  
 

  

Note The message that displays the first time when you are setting up Drainage or Utilities file is normal. This 
file will become a Utility Model and will attach the SUDA and SUE Data Base. This file will be different once 
this step is complete. 
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Exercise 4.2 Referencing the GDTMRD and SURVRD 

1. Open the Reference Dialog by using the (F9) function key and attach the GDTMRD file from the Survey 

folder.  Reference in the GDTMRD and give it a logical name of GDTM this will be used for the existing 

ground terrain. 

 

2. Attach the SURVRD with a logical name of UTEX. Open the Reference Dialog (F9) select tools attach. 

Navigate to the Survey folder, select the SURVRD file click ok this time give the logical name UTEX. 

 

3. Using the function key of (F9) open the Level Display dialog. In the level display dialog switch the level 

drop down to filters, from the filters list select the STANDARDS.UTEX filter this will apply a filter only 

displaying existing utilities levels. 
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6. Now a 3D Model needs to be created for later use. To do this step select the boundary of the 

Existing terrain, then hover over the element to bring up the context menu select the second 

icon in the list which is Set As Active Terrain Model 

 

 

7. This will create a 3D model with in the MODLRD_ExistingUtilites01.dgn file as a reference. 

 

 

8. To view the New 3D model, use the right click function to bring the View Control options 

from the list select the 2 Views Plan/3D option this will setup two views on for plan and the 

Default 3D 
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9. Now Save Settings this will save the plan and 3D default as the main views. 

 

Note If the SURVRD is displayed in View 2 Default-3D then apply the same Level filter that was in step 3 of 
these exercise (STANDARDS.UTEX) then Save settings 
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Exercise 4.3 Using the Extract from Graphics Tool 

1. Once attached open the Level Display (F10), switch the drown from Levels to Filters. Scroll down in the 

list to find the STANDARDS.UTEXRD. Click this Filter, then switch the Drop down back to Levels. This 

turns off all levels except the levels that display the Existing Utilities levels from the SURVRD file. 

 

 

2. Navigate to the default Model when there select the boundary of the existing terrain. Once selected hover 

over the element to bring up the context menu. Click the icon to set the terrain active. 
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3. Once an active terrain is set. Right click and hold the mouse button this will bring the Right Click context 

menu up. From the view control section select 2 Views Plan/3D. This will set to view windows one will be 

the default 2D view the other will be view 2 which is a 3D view. 

 

 
 

4. Switch to the Drainage and Utilities workflow in the Ribbon. Navigate to the Layout Group then 

select the Extract From Graphic tool 

DRAINAGE AND UTILITES>LAYOUT>LAYOUT>Extract From Graphics

 

5. In the Extract From Graphics Dialog match the following settings 

a. Method set to Selection. 

b. Vertical Offset set to -2.5 

c. Feature Definition set to Existing Water Main (Quality Level B) 

d. Description set to 10.” 
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6. Select all the elements the WaterB_ep lines in the file or create a Section Set of the Level 

WaterB_ep before the tool is started. 

Note If the existing utilities are 3D, then the Use 3D Element Elevations? option is activated, this property can 
be set by a check box in the Dialog instead of using the offset option. 

 

7. Following the prompts by the cursor Left-Click (Data Point) until the existing terrain needs to be selected, 

select the existing terrain as the reference surface and follow the prompts of the  
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Exercise 4.4 Show Existing Utilities in a Dynamic Cross Section 

1. Once all the existing Utilities have been Modeled a Dynamic cross section can now be used to view. 

 

 
2. The first step is to Reference the ALGNRDxx.dgn file into the MODLRD_ExistingUtilitesxx.dgn file. Open 

the Refernce Dialog by the Function Key (F9) or from the primary Group of the Home Tab Attach Tools. 

Click on the Attach Refernce icon. Navigate to find the ALGNRDxx.dgn file and attach be sure to have a 

logical name of ALGN 
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3. Fit view in each view window. Now a third view can be set for Cross Sections. Right Click and hold for the 

View Control menu. Pick the option of 3 Views Plan/XS/3D 

 

  
 

4. This will set up 3 windows one for plan, 3D and a XS. A dialog will pop up asking to Open a Dynamic Section 

View. Select Ok 

 

  
 

5. Following the prompts by the cursor a Corridor or Alignment can be select the Baseline of US98 once selected 

offsets can be entered into the dialog. Fil out as picture shows with 130.0 for the offsets and 25 for the interval 

a station can be picked form the screen. 

 

 
 

  



Chapter 4 ___________________________ EXISTING UTILITIES MODELING - Show Existing Utilities in a Dynamic Cross Section 

FDOT Roadway Design Existing Modeling  ©2021 FDOT  4-11 

 

6. There will be four Left-Click (Data Point)s that will step thru the dialog setting the left and right offsets to 

what is in the dialog then pick a station from the screen and last the interval. Next step is to pick the window 

that will be used to display the Cross Section. Click anywhere in view 7.Once the view is selected the Existing 

Ground line and Utilities are now viewable 
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Exercise 4.5 Creating a Profile From VVH data 

5 EXISTING DRAINAGE MODELING 

INTRODUCTION 

These exercises will introduce a new ORD Workflow (Menu) that will be used to layout existing Drainage 

pipes and structures. The Drainage and Utilities workflow in OpenRoads Designer will be used. When using 

the Drainage and Utilities workflow a SUDA and SUE database will be added into the file 

A new MODLRD file will be created and the optional modifier from the Create File Tool will designate it as the 

file for Existing Utilities (i.e. MODLRD_ExistingDrainage.dgn). Elements will be extracted from 2D elements 

and given Features for 3D. This will be done in order to see Existing Drainage in the 3D Model and then can be 

seen in Cross Sections View. 

 

OBJECTIVE 

Show Workflow of Creating the Existing Drainage 

Create a 3D Existing Drainage Model 

Extract from Graphics Tool  

 

EXERCISE OVERVIEW 

Exercise 5.1 Creating an Existing Drainage Model File ............................................... Error! Bookmark not defined. 
Exercise 5.2 Reference in the GDTMRD and SURVRD ................................................. Error! Bookmark not defined. 
Exercise 5.3 Create Existing Drainage from Extract from Graphic Tool ...................... Error! Bookmark not defined. 
Exercise 5.4 Show Existing Drainage in a Dynamic Cross Section ............................... Error! Bookmark not defined. 
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Exercise 5.1 Creating an Existing Drainage Model File 

1. Open the _BlankFile.dgn for the current workset that was delivered or any dgn file within the 

22049555201_CE workset. 

2. Navigate to the FDOT Tab on the Ribbon, from the Actions Group select the Create File tool to launch the 

Application. 

OPERNRAODS MODELING>FDOT>ACTIONS>Create File. 

 

3. From the Create Tool Dialog make sure to be working in the Roadway Discipline and choose the File 

Group Roadway Design Files. Now select the MODLRD Filename from the list, using the Modifier 

(Optional) box Fill out _ExistingDrainage to help designate what this file will be used for 

  

4. Click the Create – Open File the MODLRD_ExistingDrainage01.dgn will be created, close the Create File 

Tool dialog. Select the Close button 
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5. Once the file opens change the workflow from OpenRoads Modeling to Drainage and Utilities. Then 

switch to the Layout Tab and select the Place Node Tool. A message window will pop up (You Cannot 

Undo This Action) click the yes button to proceed. 

 

  
 

 

Note The message that displays the first time when you are setting up Drainage or Utilities file is normal. This 
file will become a Utility Model and will attach the SUDA and SUE Data Base. This file will be different 
once this step is complete. 
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Exercise 5.2 Reference in the GDTMRD and SURVRD 

1. Open the Reference Dialog by using the (F9) function key and attach the GDTMRD file from the Survey 

folder.  Reference in the GDTMRD and give it a logical name of GDTM this will be used for the existing 

ground terrain. 

 

 

2. Attach the SURVRD with a logical name of DREX. Open the Reference Dialog (F9) select tools attach. 

Navigate to the Survey folder, select the SURVRD file click ok this time give the logical name DREX. 
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3. Using the function key of (F9) open the Level Display dialog. In the level display dialog switch the level 

drop down to filters, from the filters list select the STANDARDS.DREX filter this will apply a filter only 

displaying existing Drainage levels. 

 

4. Now a 3D Model needs to be created for later use. To do this step select the boundary of the Existing 

terrain, then hover over the element to bring up the context menu select the second icon in the list 

which is Set As Active Terrain Model 

 

 

5. This will create a 3D model with in the MODLRD_ExistingDrainage01.dgn file as a reference. 
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6. To view the New 3D model, use the right click function to bring the View Control options from 

the list select the 2 Views Plan/3D option this will setup two views one for plan and the Default 

3D 

 

 

7. Now Save Settings this will save the plan and 3D default as the main views. 

 

Note If the SURVRD is displayed in View 2 Default-3D then apply the same Level filter that was in step 3 of 
these exercise (STANDARDS.DREX) then Save settings 
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Exercise 5.3 Create Existing Drainage from Extract from Graphic Tool 

6. From the Drainage and Utilities WorkFlow navigate to the Extract From Graphics Tool this can be found 

on the Layout Tab and Layout Group 

 

DRAINAGE AND UTILITES>LAYOUT>LAYOUT>Extract From Graphics 

 

 
7. Using the Extract From Graphics tool in the Feature Definition drop down navigate to the Feature of Exist. 

Circular Pipes and select then in the Description switch the size to 18” Pipe 

 

 

 
8. Now that the Extract From Graphics dialog is set, click in View to start the Tool this will set the selection 

Method. Following the prompts, the next step is to locate elements, select the line element between the 

structures. After the element is selected the Use 3D Element Elevations becomes active put a check in the 

box to use this. Reset to complete then there will be a number of Left-Click (Data Point)s in space to 

complete. 



Chapter 5 _____________________ EXISTING DRAINAGE MODELING - Create Existing Drainage from Extract from Graphic Tool 

FDOT Roadway Design Existing Modeling  ©2021 FDOT  5-19 

 

 
9. Once complete an Existing Drainage Structure has been Modeled. See image below. Now the Nodes at 

each end of the pipe need to be set to the correct Feature Definition 

 

 
10. To do this bring up the properties at each end by selecting the Node and hovering over click on the 

property’s icon, select the drop down in the Feature Definition and Navigate to ExMESS18RCP4S Feature 

Definition 

 

 
11. The next step is to fix the rotation to do this select the element this will bring up handles. (If this are not 

easily seen settings can be changed for better viewing) Rotate the structure to align with the center of the 

structure. 
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12. Notice in the 3D View that the pipe and structure do not line up that is because the inverts of the structure 

need to be adjusted to match the pipe. This can be done by selecting the element. But we first need to 

verify the invert by clicking on the pipe and bringing up the properties 

. 

 
13. To fix the end structures invert elevation select the element this will bring up the handles change the 

number 31.87 to 30.95 

 

 
14. Repeat for start Structure change number.  

15. From the 3D View select the shape of the pipe notice that the size is actually 12: this needs to be changed 

to the correct size 18. While selected hover over element to bring properties this can be changed here 
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Exercise 5.4 Show Existing Drainage in a Dynamic Cross Section 

1. Once all the existing Drainage have been Modeled a Dynamic cross section can now be used to view. 

 
2. The first step is to Reference the ALGNRDxx.dgn file into the MODLRD_ExistingDrainiagexx.dgn 

file. Open the Refernce Dialog by the Function Key (F9) or from the primary Group of the Home Tab 

Attach Tools. Click on the Attach Refernce icon. Navigate to find the ALGNRDxx.dgn file and attach 

be sure to have a logical name of ALGN 
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3. Fit view in each view window. Now a third view can be set for Cross Sections. Right Click and hold 

for the View Control menu. Pick the option of 3 Views Plan/XS/3D 

 

  
 

4. This will set up 3 windows one for plan, 3D and a XS. A dialog will pop up asking to Open a Dynamic 

Section View. Select Ok 

 

  
 

5. Following the prompts by the cursor a Corridor or Alignment can be select the Baseline of US98 once 

selected offsets can be entered into the dialog. Fil out as picture shows with 130.0 for the offsets and 

25 for the interval a station can be picked form the screen. 
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6. Select in view 7 to view the Dynamic Cross Section showing Drainage Structures 

 
 

 

 

6 Modeling  the Geotechnical Data and 
Report of Borings Plan Sheets   

INTRODUCTION 

 This chapter will introduce the FDOT Tools to load the Borehole data into the Geotech Data Manager and then 

use the Geotech Group from the FDOT Ribbon to create 2D and 3D models as well as the Report of Boring 

Sheets needed for Plans.  

• Introduce the Geotech Tools 

• Geotech Data Manager  

•  Place Boreholes 

•  Report of Borings 

• Become familiar with the Geotech Data Manager . 

• Become familiar with the Place Boreholes Tool 

• Place in 2D Design 

• Place in 3D Model 

Create the Report of Borings for Roadway . 
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The Tool Group that we will use to manage all the Geotechnical Data can be found within the Geotech group 

on the FDOT tab of the Ribbon within the FDOTConnectXX.xx workspace 

 

The Geotech Data Manager will created a new data base of borehole information. Open an existing xml file of 

borehole data. It will also import the different sample spreadsheets that are delivered with in the workset 

Geotechnical Folder. Once the borehole data is imported/created in the Geotech Data Manager, a xml file will 

be saved to the Geotechnical folder for the other tools to use to place in 2d, 3D and create Report of Borings 

Plan Sheets 
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Once the Borehole Data is imported and verified within the Geotech Data Manager (GDM) a xml file needs to 

be created. This can be done by the file button and then save as (recommend name is to add the FPID# as a 

prefix then Boreholes FPID#_Boreholes.xml....(22049555201_Boreholes.xml)) 
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EXERCISE OVERVIEW 

Exercise 6.1 Create and Setup the ABORRDXX.dgn for Modeling the Borehole Data both in 2D and 3D. ............ 6-4 
Exercise 6.2 Review the GeotechDataSheetTemplate.xlsx spreadsheet and then import the spreadsheet into the 
Geotech Data Manager(GDM) ..................................................................................................................................... 6-8 
Exercise 6.3 Importing the GeotechDataSampleTemplate into the Geotech Data Manager (GDM) .................. 6-12 
Exercise 6.4 Use Place Boreholes Tool to create the 2D Plan ................................................................................ 6-1 
Exercise 6.5 Use Place Boreholes Tool to create the 3D Model of Geotechnical data .......................................... 6-4 
Exercise 6.6 Use the Report of Borings Tool to create the Report of Borings sheet ........................................... 6-10 
Exercise 6.7 Create a Soil Survey Sheet for Plans ................................................................................................ 6-14 
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Exercise 6.1 Create and Setup the ABORRDXX.dgn for Modeling the 

Borehole Data both in 2D and 3D. 

 

1. Open the _BlankFile.dgn for the current workset that was delivered or any dgn file within the 

22049555201_CE workset.  

2. Navigate to FDOT Ribbon Tab of the OpenRoads Modeling WorkFlow looking for the Actions Group click 

on the Create File tool. 

OPENROADS MODELING>FDOT>ACTIONS>Create File. 

 

3. Create a ABORRDXX.dgn file with the dialog as shown below. Note your numbering may be different 

depending on how many files have been created. 

4. Be sure you set and check the county to set the correct coordinate system. Once all settings have been verified 

click the Create-Open File. 

 

5. Once the ABORRD01.dgn file displays, click Close to close the Create File tool. 

6. Using the function key (F9) to open your Reference dialog, attach the ALGNRD01.dgn from the WorkSet 

with a logical name of ALGN. Also attached the GDTMRD01 from the current workset project and give a 

logical name of GDTM. 

 

 

Note If the SURVRD file exists, the SURVRD01 -GTMRD logical can be used. 
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7. Once the references are attached, set the Terrain Active by selecting the boundary to bring up the Context 

Menu, then select the second icon in the menu. 

  

Note Setting the Terrain to Active will create a new Model that is 3D . 
 

8. Using the Right click menu of the mouse, choose  the view control and select 2 views Plan/3D. This will 

set two views on your screen 

. 
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9. Now left click data point in View 2, Default 3D to make active. Using the reference dialog (Function key 

F9), attach the ALGNRD01.dgn and give it a logical name of ALGN-2D. 

 

 

Note In order to Plot Boreholes in the Default 3D view the 2D alignment must be referenced in. 
 

10. Now Save Settings, this will save the view 1 (Plan) and View 2 (Default-3D) as the main views. 
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Exercise 6.2 Review the GeotechDataSheetTemplate.xlsx spreadsheet and 

then import the spreadsheet into the Geotech Data 

Manager(GDM)  

11. Using the FDOT Tab navigate to the Resources Group and select the Explore Directories, select the Current 

workset  

OPENROADS DESIGNER>FDOT>RESOURCES>EXPLORE DIRECTORIES>Current Workset.. 

 

12. This will open an explorer window into the current workset folder of Geotechnical. Within the 

Geotechnical folder of the workset locate the GeotechDataSheetTemplate.xlsx spreadsheet. 

Note A sample spreadsheet is delivered with the O_WORKSET_TEMPLATE that can be modified per project. 
The name of this spreadsheet is GeotechDataSampleTemplate.xlsx. User shall save a copy of this 
spreadsheet with a prefix of the FDPI# (22049555201_GeotechDataSampleTemplate.xlsx.. 

13. Open the 22049555201_BoreholeGeotechDataSheetTemplate.xlxs file to preview the column headers and 

the spreadsheets Tab for data that needs to be entered into the spreadsheet. 

 

 
 

 

 

 

 

 

 

 

 

14. There are seven Tabs in the example spreadsheet that will need Geotech data will be entered in. 

The Tabs where the user will fill out information are Boreholes, Materials, Blowcounts, Fluidlosses, 

SampleData, CoreData, Undisturbed The appropriate information depending on the Borehole Type will 

be filled out in the other Tabs of the spreadsheet. 

The DropDownList Tab will be ignored. 
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15. In the Boreholes tab the information that would be filled out are in the columns. Working from left to right 

the BoreholeId is the title of the borehole. The boreholeType and VerticalDatum are drop down menus. The 

borehole Type (Borehole Type options are Auger, Cone, SPT, Other) where the type of boring can be 

picked.  

In the Vertical Datum Tab the drop down (Options NAVD88, NVGD29) All other information will be 

filled out manually. 

 
 

 

 

 

16.  The next area that we will focus on is the location information area. Note that one type of location 

information will be entered into the spreadsheet (for this example the alignment name, station, offset are 

used).if the alignment name station and offset are not know we could use either Northing, Easting or 
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Latitude, Longitude. By default all that is needed for location infomration is Latitude, Longitude 

 

Note The Column Headers must not be changed. However you can add Columns but the Goetech Data manger 
will ignore the new columns headers. 

17. The next Tab that we will explore will be Materials Tab this tab is where the Stratum Information will be 

entered for each borehole (The Example has the different borehole data already filled out for us) Notice that 

we have multpie layers for each borehole.  

 

18. A StratumId has been used for the example (thatmeasn a number is representing the different layers). If a 

ASSHTOO or USCS classification needs to be used these will be field out by using the draopdown lists in 
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each column. If a Soil Pattern needs to be used a drop down list will be used as fro0m the SoilPattern 

Header. The SoilDescription Header will be filled out if one is provided. 

 

19. The other Tabs of the GeotechDataSampleTemplate shall be filled out if a borehole Type applys (Example 

SPT borings will use the other tabs 
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Exercise 6.3 Importing the GeotechDataSampleTemplate into the Geotech 

Data Manager (GDM) 

20. From the FDOT Tab on the Ribbon locate the Geotech Group, there you will find the tools needed to manage 

your Geotech data.  

OPENROADS MODELING>FDOT>GEOTECH 

First in the Tool Group is the Geotech Data Manager 

 

21. Select the Geotech Data Manager Icon this will start the dialog.  

 

22. Now select File from the top left corner on the (GDM) dialog. Navigate to the Import option once the 

dialog expands select either the Borehole Data Sheet will import the 

(22049555201_GeotechDataSampleTemplate.xlsx) or the Borehole Navigator Sheet this will import 

(22049555201_BoreholeSample.xlxs). This will then open an explorer window that will open to the 

Geotechnical of the workset, select the appropriate example spreadsheet (22049555201_Boreholes.xlsx) 
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23. Once the import spreadsheet is selected click on the OPEN button. 

Click OK to complete the import process. 

 

 

24. Once the information is imported into Geotech data Manager (GDM) the data can be modifed using the Edit 

button or an borehole can be added using the Add  
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25. Select Borehole-01 then select the Edit button to bring up the edit dialog where the borehole can be 

modified and verified.  
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26. Once the information has either been modified and verified select the Save button to save changes.  

 

The next step is to save the borehole data out to a xml file to be used by the other tools within the Geotech 

Group of the FDOT Tab. The recommendation for the name of the xml file is to add the 

FPID#_Boreholes.xml) Example:…(22049555201_Boreholes.xml) 
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27. Select File button in the top left corner of the (GDM) navigate to the Save As when prompted name the xml 

to 220495555201_Boreholes. then select and click Save. 
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Exercise 6.4 Use Place Boreholes Tool to create the 2D Plan 

1. Continuing in the ABORRD01.dgn that was created during Exercise 6.1 Select View 1 Default to 

set as the active View. 

 
 

2. Navigate to the FDOT Tab on the ribbon to find the Geotech Group then with in the Place 

Boreholes select from the drop down the Place in2D Plan  

OPENROADS MODELING>FDOT>GEOTECH>PLACE BOREHOLES>In 2D Plan 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. From the In 2D Plan dialog select the Browse button, this will open a windows dialog that will 

open to the Geotechnical folder within the current workset select the 22049555201_Boreholes.xml  
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4. Once the 22049555201_Boreholes.xml is selected click the Open button to load the xml into the 

tool. A few settings to check in the dialog will be the Elevation Settings make sure the dialog 

shows that the Use Surface Elevation is toggled on and the Select Surface is set to Existing 

Ground. Then select the OK button to load the data. 

 

 
 



Modeling  the Geotechnical Data and Report of Borings Plan Sheets - Use Place Boreholes Tool to create the 2D Plan __ Chapter 6 

FDOT Roadway Design and 3D Modeling ©2018 FDOT  6-3 

5. Once the Borehole data is imported a message will appear that the Drawing is complete select OK 

 
 

6. Zoom into the CL_SR61 centerline to find Borehole-01, select the cell for Borehole-01 then bring 

up the properties using CTRL+I to view the ITEM Type properties that are associated with the 

element. 
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Exercise 6.5 Use Place Boreholes Tool to create the 3D Model of 

Geotechnical data 

1. Now Select in View 2, Default -3D to make View 2 the active view.  

 

 
 

2. Navigate to the FDOT Tab on the ribbon to find the Geotech Group then with in the Place 

Boreholes select from the drop down the Place in 3D Model  

OPENROADS MODELING>FDOT>GEOTECH>PLACE BOREHOLES>In 3D Model 
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3. From the In 3D Model dialog select the Browse button, this will open a windows dialog that will 

open to the Geotechnical folder within the current workset select the 22049555201_Boreholes.xml 

 

 
 

4. Once the 22049555201_Boreholes.xml is selected click the Open button to load the xml into the 

tool. A few settings to check in the dialog will be the Elevation Settings make sure the dialog 

shows that the Use Surface Elevation is toggled on and the Select Surface is set to Existing 

Ground. Then select the OK button to load the data. 

 
 

5. Once the 3D Boreholes are placed a Drawing complete dialog will appear select and click OK. 
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6. Zoom into the CL_SR61 centerline to find Borehole-01, select the Pin for Borehole-01 then bring 

up the properties using CTRL+I to view the ITEM Type properties that are associated with the 

each element. 
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7. Now select the cylinder that was drawn you will find another Item Type named Lithography this 

will have the Stratum information. Each stratum layer will have its own colr and item type that 

describes the Lithography. 
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8. At each borehole the Water table information will be drawn also. There will be a Water Elev. Disc 

drawn that will have an Item Type describing the water Table info. 
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Exercise 6.6 Use the Report of Borings Tool to create the Report of 

Borings sheet  

1. Launch the Create File tool from the FDOT Tab on the Ribbon to create Roadway sheet file for 

the REPORT of Boring. 

OPENROADS MODELING>FDOT>ACTIONS>Create File 

 
 

2. From the Create File dialog select the Roadway Discipline, then Geotechnical Sheet Files. In the 

File type select the RPTBRD base file name. Once the RPBTRD file is selected click on the Crate-

OpenFile button. 
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3. Now that the file is created navigate to the FDOT Tab and then the Geotech Group and select the 

Report of Borings tool. 

OPENROADS MODELING>FDOT>GEOTECH>Report of Borings 

 
 

4. From the Report of Borings dialog select the Browse button and then select the 

22049555201_Boreholes.xml from the Geotechnical folder of the workset. Once selected click 

open the Open button 

 

 
 

5. Now that the xml file is loaded be sure to select the report Type for this example select the 

Roadway (Soil Stratum) Set the Annotation scale to the appropriate scale, then set the # of borings 

that will be placed per sheet. The % Vertical Exaggeration can be set to 125. Then select the 

Create Report button. 

 

 

Note The scale, Number of Borings per sheer and vertical exaggeration can be set by the user at the time that 
the sheet is created.  
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6. The boring hole information will be built in a drawing Model. This drawing model can be 

referenced into the Sheet model and then the sheet can be completed. 

 

 
 

7. Switch to the sheet model in the file. Once in the Sheet model open the reference dialog (F9) Open 

the Model dialog, navigate to the Home Tab then the Primary Group. 

 

8. With both the model dialog and reference dialog open select the BoreholeSheet drawing model 

and then drag and drop into the reference dialog to attach. The Attach Source Files dialog will 

appear set the Attachment Method :Recommended then click ok. Move the new reference in the 

sheet area within the sheet model. 
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Exercise 6.7 Create a Soil Survey Sheet for Plans 

1. Navigate to the FDOT Tab on the Ribbon, select the Create File Tool located in the Actions 

Group. 

OPENROADS MODELING>FDOT>ACTIONS>Create File 

 

 
 

2. Select the Create File Tool to open the Create File dialog box. Check the parameters from the image 

below.  

i. Discipline: 

Roadway  

ii. File Group: 

Geotechnical 

Sheet Files 

iii. File Type: 

SSUVRD 

iv. County: Wakulla 

v.  
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3.  Select the Create – Open File button. The model that the file will open to is the sheet model 

Named SoilSurveySheet 

 
 

4. Navigate to the FDOT Tab on the Ribbon. The Link Data Manager (LDM) can be found on the 

Actions Group. Select the Linked Data Manager icon to launch the dialog. 

OPENROADS MODELING>FDOT>ACTIONS>Linked Data Manager 

 

 
5. On the LDM dialog, select the create new link button. 

 
 

6. From the Link Information dialog, select Create New from Template. On the Select FDOT 

Template dialog select the Roadway Soil Survey from the Sheets category. Click OK and save 

the SoilSurevy.xlxs file in your roadway folder 



Chapter  0 _________________________________________________________________  - Create a Soil Survey Sheet for Plans 

6-16 ©2018 FDOT FDOT Roadway Design and 3D Modeling 

 

 
a. Once saved and back on the Link information dialog, from the Excel Settings section on the Link 

information dialog select sheet1 from the Worksheet drop down, click OK to place the Soil 

Survey. 
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b. Place the Soil Survey by selecting the top left corner of the border. 

 

7. Once this is placed in the file, the Soil Survey will be modified within the actual spreadsheet and not in 

the ORD dgn file. To get to the Soil Survey spreadsheet, from within Linked Data Manager, right-click 

on the Link and select Open Source. 
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